


A Note from Deputy Commissioner, KVS Delhi Region 

It is an established fact that the computer education in school plays an 
important role in overall development of students. Computer with an 
internet access is the most powerful weapon, which opens the doorway of 
all information, knowledge and skill available in this universe. However, 
there was a definite syllabus but in the absence of any study material 
transaction of the computer literacy as a subject was limited to the 
imagination of the teacher. 

With the advent of new era of artificial intelligence, it is need of the time to 
introduce technology and coding at an early stage to students, in a 
uniformed and standard way. In our endeavour to help students become 
better equipped and confident, we have taken the initiative to develop 
syllabi and textbooks which touch all the paradigm of teaching ICT in well 
directed manner. 

This book series for class 3 to 8 has been developed with efforts of many 
teachers and contributions from academicians of KVS Delhi Region. It is 
based on detailed computer literacy syllabus as per CCE(RTE) and all 
applications taught are based on free and open source software. 

The lesson is based on interaction between two students from primary 
classes to encourage auto didacticism and to teach them how to think and 
improve problem solving. We have focused on content and skills to lay a 
strong foundation for learning computers. 

The accomplishment of this venture depends on the cooperation of all 
principals and teachers who will encourage children, guide them and help 
them at different steps and give them infrastructure and proper guidance 
to use this Book. 

Comments on the book and suggestions for next edition are most 
welcome and may be sent to support@kvsrodelhi.in. 

(Nagendra Goyal) 
Deputy Commissioner 
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SYLLABUS     CLASS 4 
Quarter - APRIL  to JUNE 

Sl.No

 
Units Contents 

1 Tux Paint 

1.1 More on  stamp tool 

1.2 Shortcut keys for 

New, Open, Save, Undo,  Eraser &  Redo  

1.3 More Drawing tool  

1.3.1 Text 

1.3.2 Label 

1.3.3 Fill Magic 

1.4 Magic Tools 

1.4.1 Bricks 

1.4.2 Calligraphy 

1.4.3 Flower 

1.4.4 Grass 

1.4.5 Foam 

1.4.6 Rainbow 

1.5 More Magic Effect 

1.5.1 Calligraphy 

1.5.2 Mosaic Effect 

1.5.3 Kaleidoscope Effect 

1.5.4 Emboss Effect 

1.6 Deleting a drawing  

1.7 Slides Show 

2 Scratch 

 

    

3 SCRATCH 

 3.1 Playing with sounds—Sound Block 

  3.1.1. Play sound... until done…. 

  3.1.2. Start sound 

  3.1.3. Change volume by 

  3.1.4. Set volume to 

  3.1.5. Change…. effect by 10 

  3.1.6.  Set pitch effect to 100 

  3.1.7. Stop all sounds 

  3.1.8. Clear sound effects 
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Quarter - July  to September 

3 
SCRATCH 

(Contd.) 

3.2 Adding an extension— “Text to speech”. 

3.3  Looping—control block. 

3.3.1. “repeat 10” block 

3.3.2. “repeat until” block 

3.4 "touching?” block —sensing block 

3.4.1. “Touching mouse-pointer?” block 

3.4.2. “Touching color?” block 

3.4.3. “color is touching?” block 

 3.5 If block —control block.  

3.5.1. “If condition? Then” block 

3.5.2. “If condition? Then…else” block 

3.6 “wait until” block 

3.7 Stop block —control block 

3.7.1. Stop all 

3.7.2. Stop this sprite 

3.7.3. Stop other scripts in sprite 

4 Writer 

4.1 Page settings- Color, Background, Margin, Page 

 4.2 Paragraph settings- indentation, background 

color, Line Spacing 

4.3 Inserting page break 

4.4 Inserting image, shape 

5 

INTRODUCTIO

N TO DIGITAL 

PRESENTATIO

N - IMPRESS 

5.1 Introduction to Digital Presentation 

5.2 Getting started with LibreOffice Impress 

5.3 Main Impress Window 

5.4 Close LibreOffice Impress 

5.5 Close a Presentation 

5.6 Creating Presentation 

5.6.1 Using new option 

 5.6.2 Using Template 

5.7 Slide Layout 

5.7.1 Selecting a new Layout 

5.7.2 Changing Layout of Current Slide 

5.8 Save a Presentation 
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5.8.1 Using Save 

5.8.2 Using Save as 

5.9 Contents in Slide 

5.9.1 Adding Content 

5.9.2 Delete Content 

5.1 Formatting Toolbar 

5.10.1 Text Formatting 

5.10.2 Paragraph Formatting 

5.11 Adding Images in Slide 

5.11.1 From file 

5.11.2 From Gallery 

5.12 Formatting images 

5.12.1 Move 

5.12.2 Resize 

5.12.3 Rotate 

5.13 Slide Show 

5.13.1 From first Slide 

5.13.2 From Current Slide 

Quarter - October to December 

6 Libreoffice Calc 

6.1 What is Calc 

6.2 How to start LibreOffice Calc 

6.3 Parts of Calc Window 

6.4 Title Bar 

6.5 Menu Bar 

6.6 Toolbars 

6.7 Status Bar 

6.8 File Menu 

  6.8.1.       Creating a new spreadsheet 

6.8.2.      Opening an existing spreadsheet 

6.8.3.      Saving a spreadsheet 

6.8.4.      Closing a spreadsheet 

6.8.5.      Print Previewing a spreadsheet 

6.8.6.      Printing a spreadsheet 

6.9 Edit menu 
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  6.9.1.     Undo 

6.9.2.    Redo 

6.9.3.    Cut & Paste 

6.9.4.    Copy and Paste 

6.9.5.    Find 

6.9.6.    Find and Replace 

7 
Exploring 

Windows 10 

7.1 What Is Windows 10 

7.2 File Explorer 

7.3 Different Ways To Open File 

7.4 Components Of File Explorer 

7.5 Panes Of File Explorer 

7.6 Managing Files And Folders 

8 
Classification 

of computer  

8.1 Classification Of Computers 

8.2 Analog 

8.3 Digital 

  ·        Size And Performance 

  ▪         Super Computer 

  ▪         Main Frame 

  ▪         Mini Computer 

  ▪         Micro Computer 

  ▪         Embedded  

Quarter - January  to March 

8 
Classification 

of computer  

  ·     Purpose Wise 

8.4 General Purpose 

8.5 Special Purpose 

8.6 Hybrid 

9 
Windows 

Accessories 

9.1 Modes of View 

9.2 File naming convention 

9.3 Searching Files 

9.4 Creating Shortcuts 

9.5 Calculator 

9.6 Onscreen Keyboard 

9.7 Magnifier 

9.8 Task view 
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1. TUX PAINT 
 

1.1 More on Stamp tool  

1.2 Additional stamps 

1.3 More Drawing tools 

1.3.1 Text 

1.3.2 Label 

1.3.3 Fill  

1.4 Magic Tool 

1.4.1 Bricks 

1.4.2 Blur 

1.4.3 Flower 

1.4.4 Grass 

1.4.5 Foam 

1.4.6 Rail 

1.5 More Magic Effect 

 Calligraphy 

 Mosaic Effect 

 Kaleidoscope Effect 

 Emboss Effect 

1.6 Deleting a Drawing 

1.7 Slide show 
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1.1 More on Stamp tool  

Gowri:-Hey Aryan, Check out my digital drawing in tux paint. 

 
Aryan: - This is so good. Did you paint these birds yourself?  

Gowri :- No Aryan, We have some inbuilt stamps in Tux Paint. 

Aryan :- Is it, please tell me more about it.  

Gowri :- Stamp tool is a simple tool that is used to put a stamp and 

add images in your drawing. Tux Paint already has some in‑built stamps. 

Funny sound effects are also played when we select any tool. Let me tell 

you the steps for it. 

 

Fig. 1.1: Using stamp Tool 
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1.2 Additional stamps can be downloaded from the following 

website  

Step 1:  Select the Stamp from the Tools 

Step 2: Select a particular stamp from the stamps option available in right side 

Step 3: Resize your stamp by using the resize button  

Step 4: Then click on the Work area, you will get your stamp in your drawing.  

1.3 More Drawing tools  

Gowri: - We have already studied the paint, stamp, lines and shapes tool in 

previous class. Let’s study about more tools.  

Aryan: - Yes please, I would like to know how you have labelled your 

drawing. 

1.3.1 Text Tool  

Gowri: - For this I have used Text tool. This tool is used to write text in your 

drawing using keyboard. 
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Fig. 1.2: Using Text/Label Tool 

Step 1: Select Text from tools 

Step 2: Select a particular font  

Step 3: Select a particular color 

Step 4: Then type the text  

Step 5: Press enter to write new text 

1.3.2 Label Tool  

 This tool is the same as the text tool for writing the text in our drawing. 

1.3.3 Fill Tool  

 This tool is used to fill a flood-colour to your drawing. 

Step 1: Select the Fill 

tool 

Step 2: Select a 

particular colour from 

colour palette 

Step 3: Click the area 

where you want to fill 

that colour. Like I have 

filled in grey colour as 

background. 

                         Fig. 1.3: Using Fill Tool 

1.4 Magic tools  

  The most special feature of Tux paint is the Magic tool. It gives amazing 

effects to our drawing. Let’s explore some magic tools 
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Fig. 1.4: Using Magic Tool 

1.4.1. Bricks  

 It fills bricks into the pictures as shown in figure. 

Step 1: Select the magic tool 

Step 2: Select brick from the selector 

Step 3: Click & move the mouse pointer on the work area 

 Like this we can apply other magic tool in our drawing as explained below  

1.4.2. Blur Magic  

 It is used to blur the area of drawing.  
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Fig. 1.5: Using Flower/Bricks/ Blur Magic options 

1.4.3. Flower Magic   

 It is used to draw the flower in your drawing  

1.4.4. Grass Magic 

 This draws grass in your drawing as shown in figure. You can make a 

garden using this tool. 

 

Fig. 1.6: Using Grass/Rail/Foam Magic options 
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1.5.3 Kaleidoscope Effect  

 This tool is used to create a freehand pattern. When you select this tool 

and move the magic wand then it will draw in four directions automatically.  

1.5.4 Emboss Effect  

 This tool increases the effect to an object from the surface of your 

drawing. Like this we can apply a number of magic options from magic selector 

and to make our drawing interactive. 

Gowri:- I have tried some digital drawing using all these. Can you 

try these. 

Aryan :- Yes, sure I will try.  

     

1.6 Deleting a Drawing 

 Deleting means to permanently remove a drawing from your computer. 

Please carefully delete the drawing which you want to delete. 

Step 1: Select on the open Tool  you will see all the saved drawing 

thumbnails on the screen 

 Step 2: Select the drawing which you want to delete 

Step 3: Click on the Erase  button present at the right bottom of the 

screen. 

Step 4: Then click on Yes, Erase it! 
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After this your selected drawing will be erased from the system.                                            

                         Fig. 1.8: Using delete a drawing 

1.7 Slide show 

Gowri: - Do you know you can show different drawings in your file as a 

sequence, which will give little animated or movie effect. This is called as slide 

show. 

Aryan: - Really, please show me how it is done.  

Gowri: - Let me tell you step wise. 

Step 1: Select on the open   you will see all the saved drawing 

thumbnails on the screen.       
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Fig. 1.9: Using Slide Show 

Step 2: Click on the 

Slides  options  

Step 3: Select the 

drawing which you 

want to display in your 

slide show 

Step 4: Each picture 

get a number which 

you select, you can 

reorder the pictures 

Step 5: Adjust the 

speed of the slides by selecting the sliding scale.        Fig. 1.10:  Slide Show Play 

Step 6: Click on the play  button to begin the slide show  

Step 7: Press spacebar, Enter, Right arrow key, or next button to move the 

next slides 

Step 8: Press Esc key to come out from the slide show. 

 

Fig. 1.11:  SlideShow 
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Aryan: - This slide show is amazing. But I have noticed 

that many a times it gets difficult to click on menu 

options for different commands. I wish I had some easy 

way for that.  

Gowri: - There is one. We have some Shortcut keys for 

New, Open, Save, and Undo & Redo options. You can use 

them to do fast work in Tux Paint. 

 New:  Press ->        Ctrl + N 

 Open:  Press->  Ctrl + O 

 Save:  Press->         Ctrl + S 

 Undo:  Press ->   Ctrl + Z 

 Redo: Press ->   Ctrl + R 

Why don’t you give it a try? And make a project. I will guide 

you how to start it. 

 

 

Project:  Make a slide show of Fox and crow story as shown in fig. 1.12 

 
 

 
 

Fig. 1.12: Fox & Crow Story 
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Steps 1: Draw a tree and color it 

Step 2: Select the flower stamp and grass stamp and draw the flowers and 

grass 

Step 3: Select the stamp tool and select crow and fox stamp 

And draw one crow and a fox. 

Steps 4: Select the cheese stamp and draw in crow’s mouth 

Steps 5: Select Text stamp and write the text of the story 

Steps 6: Make like this 3 or 4 slides as per fox and crow story 

Step 7:  Save and play slideshow of your drawing. 

 

Something To Know 

Exercise 
A. Answer the following questions. 

1. What is a Stamp Tool? Write the name of any two stamps of Tux paint. 

2. Why do we use shortcut keys? 

3. What is Magic Tool? Write the name of any two magic options. 

4. Write down the steps to delete a saved drawing? 

5. How to make a slideshow in Tux paint? 
 

B. Fill in the Blanks 

1. __________ is the tool to type text on your drawing. 

2. We should click on ______________ button for the slideshow. 

3. _______________is the magic tool which draws in four directions. 

4. ______________is the shortcut key for the New Drawing. 

5. To make a track we use _______________ magic effect. 
 

C. Match the Following: 

1. Emboss effect a) Ctrl + Z 

2. Stamp tool 
b)  

3. Kaleidoscope effect 
c)  

4. Mosaic effect d)  
5. Shortcut for Undo 

e)  
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D. Select the correct answer for each question : 

1.  Shortcut keys for Redo  is  

(a)  Ctrl + Del   (b) Ctrl + O  (c) Ctrl + R  (d) Ctrl + Z 

 

2. Which is not the Magic tool options from the following : 

(a) Mosaic effect  (b) Color effect  (c) Emboss effect (d) Rail effect 

           

3. To exit from the slide show, we should press the following key 

(a) Del     (b) Insert    (c) Esc    (d)  Shift  

 

4. Which of the following tools is used to create the freehand pattern? 

(a) Mosaic effect(b) Kaleidoscope effect (c) Emboss effect (d) Rail 

effect 

 

5.  Which of the following magic tools is used to draw bubbles? 

(a) Foam effect  (b) Brick effect  (c) Emboss effect (d) Rail effect 

 

QUESTIONS BASED ON CCT  

 

E. State True  or  False (Give Reasons) 

1. Mosaic effect lightens the color of an object. 

2. You can draw flowers with the help of flower magic tools. 

3. Fill tool is used to fill the color to an area. 

4. Shortcut for saving a drawing is Ctrl + P. 

5. Pictures in a Slideshow are marked P, Q, R and so on. 

 

SOMETHING TO DO 

1. Create an interactive drawing using various stamps 

2. Create a slideshow to show a story. 
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Aryan: Thanks, Gowri, for showing labels also in this scratch 

window. Yes, all these are the components of the scratch 

software. Could you give the definitions of these components also? 

Gowri:  Yes Aryan, sure. Following are the components of “Scratch 

Desktop window”: - 

1. Tabs: - There are three tabs in Scratch: -      1. Codes  2. Costumes    

3. Sounds 

2. Blocks: - There are 9 round buttons of different colors 

known as blocks, they are as follow: -Motion, Looks, 

Sound, Events, Control, Sensing, Operators, Variables, My 

Blocks. 

3. Block Palette: - This is a place where we have blocks of 

instructions to perform some specific task by the sprite 

under different rounded blocks. 

4. Scripts Area: We can write code or script here by dragging and dropping 

the blocks from blocks palette and join them together to perform the 

tasks in a sequence.     

5. Sprite: - An object which can perform any task like, move, turn, fly, jump 

etc. 

6. Sprite List: - We can see a list of selected sprites of our project here 

and we can also remove them from here using the delete button given on 

top of the sprite.   

7. Choose a sprite: -We can add, upload and draw sprites of our own choice 

using this icon. 

8. The Stage: We can see our sprites moving here and interact here. 

9. Flag/Stop: -When Flag is clicked then code runs, and when stop is clicked 

the code is stopped.   

Aryan: Thanks, Gowri, for explaining these components.   

Gowri:  Yes Aryan, now tell me please, can we do the coding for 

more than one sprite simultaneously? 

Aryan: Yes Gowri, we can add any number of sprites in 

our project and we can do coding on more than one sprite 

simultaneously. We can also draw and upload the sprites of our 

own choice also.  
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Try it by Yourself 2.1 Add any number of sprites in your project and 

also use “paint” and “upload sprite” options also to add new sprites. 

 

Gowri:  Yes, right Aryan, tell me, can we move, turn and fly the sprites. 

Remind me the names of the blocks to perform these tasks. 

Aryan: Yes, I know this Gowri,  

1. “move … steps” block is used to move the sprite forward or 

in backward direction and  

2. “turn…. degrees” block is used to turn the sprite in the left 

or right direction to an angle given by us. 

3. “glide...” block is used to fly or float the sprite to a random 

position or to a particular (x,y) direction. 

Gowri:  Yes, you are right Aryan. You also know 

that sprites can also say a message and switch its costume as 

well. Please tell me the names of the blocks to perform these 

tasks. 

Aryan: Yes, I know this also Gowri, these blocks are: - 

1. “switch costume to” or “next costume” block is used to change the 

costume of a sprite. 

2. “Say…” or “Say… for … seconds” block is used to say any message by 

the sprite in a bubble pulled out.  

3. “think…” or “think… for … seconds” block is used to say any thinking 

message by the sprite in a thinking bubble pulled out. 

Gowri:  Yes, you are right Aryan. But do you know what is the 

difference between “switch costume to” and “next costume” 

block?  

Aryan: Yes, I know this also Gowri, but I have doubts about 

this topic. So, please tell me this also to clear this topic more. 

Gowri:  Ok! Sure Aryan. “switch costume to” block has a drop-

down menu and is used to choose the costume from the list 

given in the drop-down as per our choice. But by “next 

costume” block scratch automatically chooses the next 

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 17                                                  KVS DELHI REGION 2021 
 

costume from the list. We can’t choose the costume-name from our own 

choice. 

Aryan: Thanks, Gowri, for explaining this to me. 
 

Try it by Yourself 2.2 Add any number of sprites in your project and 

make a story by changing its costumes one by one. Sprite will also display 

the text messages in bubbles, before changing the costume. 

Gowri:  Ok! Aryan. Now please tell me how you can make your project more 

interesting? 

Aryan: Gowri, yes, I have made very interesting projects in last 

class by making it more colorful. I have also changed the 

background of my project. So, we can also choose any number of 

backgrounds by choosing it from the “choose a Backdrop” icon on 

the right bottom corner.  

Gowri:  Yes, you are right Aryan. But do you know, could we 

choose more than backgrounds for one project and which block 

will be used to change the background from time to time by 

writing a code. 

Aryan: Yes Gowri, I have chosen so many backgrounds for one project. I have 

also used the following blocks to change the background from time to time. 

These blocks are: - 

1. “switch backdrop to” or “next backdrop” block is used to change the 

background in a project. 

Gowri:  Yes, you are right Aryan. Same difference is between 

these two blocks as we have discussed for “switch costume to” 

or “next costume”. As you know, we can choose any number of 

backdrops from the “choose a backdrop” icon, but do you know 

how you can remove or change the selected list of backdrops?  
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Aryan: Yes, Gowri, it’s possible dear in scratch. I have made so 

many scratch projects where, sprite is changing its size and color. 

I like these blocks very much. One more block that I have liked very 

much is “forever block”. 

Gowri:  Very Good, why do you like this block very much? 

Aryan: Yes, Gowri, this is my favorite block, as I don’t have to write the 

statements again and again. It will repeat the blocks written inside it, infinite 

times, automatically. But my project has no sound till now. It’s not feeling good 

to me. What should I do dear? 

Gowri:  Yes, Aryan you are saying right. Scratch also has the “Sound” block. 

That we will learn in the next chapter. Till then goodbye! Have a nice day. 

Aryan: Yes, Gowri, thanks dear, I am very much eager to learn this. Good bye, 

and Have a nice day. 

 

Something To Know 

Exercise 
A.  Answer the Questions given below: 

Q: -1 You have seen so many blocks in the scratch now. Write their names 

to do the following tasks. 

Action        Name of Block  

a. To float the sprite to a random position    ___________  

b. To display a message and then wait for 3 seconds  ___________  

c. To turn the sprite right side by 50 degrees.   ___________  

d. To move the sprite by 5 steps backward.    ___________  

e. To change the costume of the sprite automatically one by one.  

           ___________  

f. To increase the size of the sprite by 20 values.  ___________ 

Q: -2 Under which block “change color effect by…” block is available in 

scratch? 

Q: -3 What is the meaning of “glide to…” block? 

Q: -4 What is the meaning of “hat” block? 

Q: -5 “move -20 steps” block is used for _____________. 

Q: -6 Explain “when backdrop switches to” block. 
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B. Fill in the blanks given below: - 

1. _________________ block, is used to turn the sprite left side. 

2. “turn…” block is under the __________ block. 

3. ________ icon is used to draw the sprite, when it is required. 

4. _____________, ______________ and ____________ are the tabs 

available in scratch. 

5. All the selected sprites will appear in ____________ list. 

6. ____________ tab is replaced with _________ tab when we will 

choose, stage option from scratch. 

 

C. Write the name of “type of block” for the following blocks. Also 

write the name of block under which this block exists: - 

Name of the block  Type of Block  Name of Block 

1. “switch costume to…”  _____________ _____________ 

2. “wait … seconds”   _____________ _____________ 

3. “say… wait for … seconds”   _____________ _____________ 

4. “when backdrop switches to”_____________ _____________ 

5. “when flag clicked”  _____________ _____________ 

 

Task to do/something to do: - 

 

 

 

 

 

 
 

  

  

 Create scratch project having more than one sprite in it. 

These sprites are talking with each other also using “say” 

block.  

 Create a story in scratch of your own. 

 Create a story of birthday party having different food items 

and also balloons moving here and there. 
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3.SCRATCH

3.1. Playing with sounds—“Sound” Block 

3.1.1. “play sound... until done…” block 

3.1.2. “start sound” block 

3.1.3. “change volume by…” block 

3.1.4. “set volume to…” block 

3.1.5. “change… effect by…” block 

3.1.6. “set… effect to…” block 

3.1.7.  “stop all sounds” block 

3.1.8. “clear sound effects” block 

3.2. Adding an extension— “Text to speech”. 

3.3. Looping—“Control” block. 

3.3.1 “repeat…” block 

3.3.2 “repeat until…” block 

3.4. “Touching?” block —“Sensing” block 

3.4.1. “touching mouse-pointer?” block 

3.4.2. “touching color?” block 

3.4.3. “color is touching?” block 

3.5. If block —“Control” block.  

3.5.1. “if…condition?…Then” block 

3.5.2. “if…condition?…Then…else” block 

3.6. “wait until…” block 

3.7.  Stop block —“Control” block 

3.7.1. “stop all” block 

3.7.2. “stop this sprite” block 

3.7.3. “stop other scripts in sprite” block 

Aryan: - I was thinking that what if I want my sprite to make 

some sound for effects. 

Gowri: Yes, I told you that sprites can also play some sounds. But 

every sprite has few fixed sounds in scratch. You can choose the 

sound from the option given already.  

Aryan: OK! Then please tell me how to do this now. 
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Gowri: Sure! Sure! There is one block, named “sound”, which has 

8 different blocks and also there are extensions in scratch for 

sound. First, let me tell you about Sound block and later I will 

tell you about extensions of the scratch for sounds. 

3.1. Playing with sounds— “Sound” Block: - All these 8 blocks are stack 

blocks. 

Sprites can play different sounds through sound block. Sounds of the sprites 

are built-in, meaning it's fixed, we can choose any sound from these lists by 

using any one of the blocks, given below. 

3.1.1 “play sound... until done…” block: - This block chooses the sound 

and plays the selected sound and finishes it before moving to the next 

script. It pauses the script till it ends. 

3.1.2 “start sound” block: - This block also chooses the sound and then 

play it, but not stops the next script. It plays the sound with the next 

script but sound will overlap with next sound, so, we have to use the 

“wait for 1 seconds” block from the control block if we want to play 

the next sound. 

Aryan: OK! Wow, It means sprite can play the sounds now. But could 

we increase or decrease the volume of the sound also.  

Gowri: Yes, dear! We can also change the intensity or volume of 

the sound also, as we did in our Laptops or in TVs. Let’s learn it 

now with the following 2 options:  

3.1.3 “change volume by…” block: - This block is used to 

increase or decrease the volume of sound by a particular value. If 

value is a +ve number then sound will increase and when value is a -ve 

number then sound will decrease. 

3.1.4 “set volume to…” block: - This block is used to set the volume of 

sound to a particular value. 

Aryan: OK! But could we increase or decrease the speed of the sound also.  

Gowri: Yes, dear! We can also change the speed of the sound also, as we did in 

some videos. Let’s learn it now with the help of following 2 options:- 

3.1.5 “change…effect by…” block: - This block has a drop-down menu; 

we can choose one option out of two options: pitch and pan Left/ 

Right. 

3.1.5.1 “change pitch effect by…” block (means when pitch is 

selected), It means speed or pitch of the sound changes by a value which 

we will give. If the value is +ve means, pitch of the sound is increasing and 
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 Drag “Change volume by -10” block in the script area, which is used to 

increase or decrease the sound of Tabla. Minus symbol is used to 

decrease the sound. So, change its value to 30 to increase the sound by 

30. 

 Then drag “play sound … until done” block in the script area, to play a 

sound completely. Now choose any sound of tabla. (e.g. Hi Tun Tabla). So, 

there is no need for a “wait” block, as it finishes the sound completely 

before moving to the next script. 

→ STEP-03 

 Drag “Change pitch effect by 10” block in the script area, which is used 

to change the speed of the sound of table sprite. Now change its value 

from 10 to 30. (For increasing its speed). 

 Then drag “play sound… until done” block in the script area, to play a 

sound completely. Choose any sound of tabla. (e.g. Hi Tun Tabla). So, no 

need of wait block now. 

→ STEP-04    Repeat the step-03 again.  (See script/code in figure 3.1) 

→ STEP-05  When we click on the “flag” now, the sprite “tabla” plays the 

sound four times, but when we next click the flag, speed of the sound increases 

every time. To remove all these effects, do the following more steps: -  

i) Drag the blocks “clear sound effects” and “set volume to 100%” and drop 

these blocks one by one under “when flag clicked” block.  

ii) So, every time when we click on the “flag”, the sound starts from initial 

“volume and speed” of the sound and this will remove all the previous effects 

from sound.  
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Something To Know 

Exercise 
 

Q: -1 you have seen so many sound effects in scratch now. Write their 

names to do the following tasks. 

Action        Name of Block  

a. Change the pitch of the sound of sprite   ___________ 

b. Increase the volume of the sound of sprite   ___________  

c. Decrease the speed of the sound of sprite   ___________  

d. Remove all the sound effects      ___________  

e. To set the pitch of the sound of sprite to a specific value___________ 

f. To stop any kind of sound of sprite    ___________ 

Q: -2 Under which block “clear sound effects” block of instructions 

available in scratch? 

Q: -3 What is the meaning of “set pitch effect to…” block? 

Q: -4 What is the meaning of “change pan Left/Right effect by…” block? 

Q: -5 “change volume by…” block is used for _____________. 
 

Task to do/something to do 
 

 

 

 

 

 

 

 

 

  

1. Add a sprite in your project from “music” tab. And play sounds and 

also it changes their sound pitch effects after every 1 seconds, when 

we click on Flag. 

2. Write the script for showing a birthday party scene with different 

sounds and dance movements. (Hint: change the costume and sounds 

of sprites.) 
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3.3. Looping—“Control” block: - 

3.3.1 “Repeat 10…” block: - This is also known as “c-block”, which 

is used to repeat the blocks of instructions for some specific 

number of times.  

3.3.2 “Repeat until…” block: - This is also known as “c-block”, 

which is used to repeat the blocks of instructions till some condition 

is false. If the condition becomes true, then it runs the next 

instructions written after the “repeat” block. 
 

Aryan: What is this “c-block”? Please explain it.  

Gowri: Sure dear! “c-block” means these blocks are in the shape 

of “c character” of English alphabets. These blocks can have any 

number of statements written inside it.  

Aryan: Ok, dear, now could you please explain me, what is the 

“condition”?  

Gowri: Sure dear! Ok, please tell me the answers to some questions I am 

asking to you. 

1. Is 4+5=9? 

2. Are you studying in class 4? 

3. Are you going to school daily? 

Aryan: “Yes”, is the answer of all these questions. But why are you 

asking these questions to me? 

Gowri: Yes, because all these questions are having some answers 

and based on those answers, I will make decisions. So, all these 

questions will become conditions. And answers to these 

questions are in the form of “yes” or “no” only. If I want to make 

some decisions based on a question, then the question becomes 

condition.  

Aryan: Oh! I come to understand now, what are the “conditions”? Thanks, dear 

Gowri, for explaining this to me. 

Gowri: Let’s learn “repeat until…” in detail with the help of an activity. 
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Activity -3.3: Take the same example of fish we studied in previous 

class, add a fish sprite in your project with an underwater background. 

Create the same sprite in duplicate form and float both the fishes in 

random positions till these fishes do not touch each other. Means if 

these fishes touch each other then it will play sound and stop floating. 

Gowri: Before moving to the solution, one more block is to be learned now, 

which is given below: - 

3.4. “touching?” block — “Sensing” block: - All these are “Boolean” blocks. 

3.4.1 “touching mouse-pointer?” block: - This is known as “Boolean” 

block, as this has hexagonal like shape. This block has a 

“?” question mark means it is asking a question and an 

answer needs to be returned as true or false. And this block also has 

drop-down menu so has three options, which are: - 

3.4.1.1 “touching mouse-pointer?” block :-> This block is used 

to ask whether the sprite is touching the mouse pointer or not. 

3.4.1.2 “touching edge?” block :-> This block is used to ask 

whether the sprite is touching the edge of the stage or not. 

3.4.1.3 “touching sprite?” block :-> This block is used to ask 

whether the sprite is touching another sprite (name of sprite 

appears automatically) or not. 

3.4.2 “touching color?” block - This is also a “Boolean” block, and asks 

whether the sprite is touching a color or not. You can choose a color of 

your own choice which you want to compare. 

3.4.3 “color is touching?” block - This is also a Boolean block, and ask 

whether the color specified on the left side in stage is touching the 

color given on the right side or not. You can choose a color of your own 

choice which you want to compare. 

Aryan: Ok! Thanks, dear, for telling this, I get it, we will use these blocks to 

check whether fish is touching another fish or not. 

Gowri: Yes dear, we will use this block for checking, whether both sprites are 

touching each other or not, in the next steps, given below: 
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Aryan: Oh Yes! Same coding with two different methods. So, 

it means  “if…then…else” block is also used for conditions. 

Please tell me something about this. 

Gowri: Yes, dear Aryan! This block is used to 

check conditions and to take decisions based on that condition. 

This block has different options and their meanings. Let’s 

understand this now: - 

3.5. If block— “Control” block: - These blocks are also known as “c-block”. 

3.5.1 “If   condition? Then” block: - This block, is used for asking the 

questions and returning the answer in true or false. If the condition is 

true, then the blocks written inside this c-block will be executed, 

otherwise not. 

3.5.2 “If   condition? Then…else” block: - This block, is used for 

asking the questions and returning the answer in true or false. If 

condition is true, then the blocks written inside this c-block will be 

executed, otherwise the blocks written inside the “else” block will be 

executed. 

3.6. “wait until…” block —“Control” block: - Like “if” block, condition is also 

written in this block and here it will wait till the condition is false. When 

the condition becomes true, then the next block of instructions will be 

executed. This is also known as “c-block”. 

Aryan: Ok dear! Thanks, for explaining this block. Now please tell 

me what is this “stop all” block?  

Gowri: yes, sure dear, this block is a “cap” block and has a drop 

down also. 

Aryan: What is this “cap” block? I have heard about “stack” block, “hat” 

block, “c-block”, “boolean” block but what is this “cap” block now?  

Gowri: Yes dear, “cap” block is the block which ends the 

script here, means no more block can be added after that 

block. We can also say it as the reverse of “hat” block. “Hat” 

block is the start of the script and “cap” block is the end of 

the script. 

3.7. Stop block— “Control” block: - This is a “cap” block.  

Gowri: Let’s understand this now that this block has three options in 

dropdown which are:- 
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3.7.1. “stop all” block: - This means, it will stop “all” the scripts 

running in scratch project, either on this sprite or any other sprite. 

3.7.2. “stop this script” block: - This means; it will stop all the running 

scripts of this “sprite” only in scratch project. 

3.7.3. “stop other scripts in sprite” block: - This means; it will stop all 

the running scripts of this sprite, written under any “hat” block. 

ARYAN:  OK! Thanks, dear Gowri, today I have learnt so 

many interesting blocks of scratch. With these blocks, I 

could make so many games etc. But I wish, sprites can create 

so many copies of themselves and also destroy them 

automatically.  

GOWRI: Yes dear, it's definitely possible that 

copies of the sprite can be created 

automatically, as and when required and can also destroy itself 

when required. But we will learn these blocks in the next class. 

Aryan: Ok Dear Gowri, I am very much excited to learn these blocks also. 

Thanks, dear, for these blocks that you have taught me in this class. 

  

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 35       KVS DELHI REGION 2021 

Something To Know 

Exercise 

A. Answer the questions given below: - 

1. What is the meaning of “repeat until…” block?

2. Under which block “repeat until…” block is available in scratch?

3. Write difference between “repeat” block and “forever” block?

4. What is the meaning of “if…Then… else” block?

5. What is the meaning of “stop all” block?

6. What is the meaning of “play sound… until done”?

7. What is a “cap” block?

8. How many blocks are available under extension “Text to Speech”?

B. Fill in the blanks given below: - 

1. _________________ block, ends the script.

2. “touching mouse-pointer?” block is present under __________ block.

3. ________ block is used to stop all the codes of only the sprite where it

is written.

4. “touching sprite2?” block is used for______________.

5. “repeat until” block is a ____________ block.

6. ________ Extension has blocks which helps the sprites to speak.

Task to do/something to do 

1. Create a game of your own choice using different sprites and

conditions.

2. Create a project in scratch showing fruits moving here and there and

snake is eating it and finishing it.

3. Create a story of birthday party having different food items and also

having music and fun like balloons moving here and there.
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Margins 

can be set 

in the page 

tab of the 

page style 

dialog box 

 

 

Fig 4.8 

4.1.5 PAGE SIZE 

Papers are available in different sizes for printing. We must define the page 

size for a document so that is fits onto the page well when we take a print out 

of our document. 

 
Fig 4.9 
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We can 

select an 

appropriate 

paper size 

from Paper 

Format 

option 

available in 

Page tab. 

Fig 4.10 

4.2 PARAGRAPH SETTINGS 

Consider the paragraph in the image below for learning all the paragraph 

settings  

Fig 4.11 

We can do all type of paragraph settings from the paragraph menu item in 

the format menu as shown below. 
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Fig 4.16 

4.3 INSERTING PAGE BREAK 

When we keep entering text into a page, the control automatically gets shifted 

to new page when the current page gets filled. But if we want to leave space 

for some special purpose and want to move to a next page or wants to begin a 

new paragraph on the successive page, we can use a page break option after 

placing the cursor at a point from where we want a new page to begun. 

Or we can use Ctrl+ Enter to insert a page break. 
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     Fig 4.17 Fig 4.18 

Images before (Fig 

4.18) and after 

(Fig 4.19) a Page 

Break 

Fig 4.19 

4.4 INSERTING IMAGES AND SHAPES 

We can quickly add images to our document by using image menu item in insert 

menu and then selecting a saved image from the computer as shown below. 

Fig 4.20 Fig 4.21 
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Let us revise we have learnt: 

 Page settings can be done from page style menu option under format menu

 We have a separate page tab in the side bar to quickly do all types of

page settings

 We can apply borders on a page

 We can change the colour and background of the page

 We can do paragraph settings from paragraph option in the format menu

 We can use indents indicate the beginning of a paragraphs

 We can use border and background for a paragraph also.

 We must do the paper settings properly to get a better printed document

Exercise

Something To Know
A. Answer the following questions. 

1. How the pattern option is different from bitmap option?

2. Lalit wants to insert the school logo in his document. How can he achieve

this?

3. What are margins?

4. What are the dimensions of an A4 paper in inches?

5. Write the steps to insert a page break in a document

B. Fill in the Blanks. 

i.To apply page settings, we need to open the ________ on the side bar

ii. We can __________ spacing between two lines by using line spacing

option. 

iii. BITMAP option is used to insert image at the ____  background.

iv._______ is the space we leave before a line. 

v.We can select an appropriate paper size from _________option available

in Page tab.

C. Match the following 

a) page break p) single, double, 1.5, proportional

b) flowcharts are part of q) to move to a new page

c) page style in r) indentation

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 49       KVS DELHI REGION 2021 

Something to do in Lab 
1. type the following paragraph with all formatting applied on the paragraph.

2. Click a picture of school garden and set it as background of your

document. 

3. Add all available page sizes names on the document prepared in point 2.

Using page break, add another page and add all available line spacing. 

The Word completion facility is little different than Auto 

Correct facility. While typing as and when you type two-three 

characters, Writer tries to guess which word you are typing and 

offers to complete the word for you. To accept the suggestion, 

press Enter. Otherwise, continue typing.  

Note that this facility is available only for those 

words which are already typed in the same document that 

is the word completion facility is available for a word 

getting typed at least for second time. 
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5. INTRODUCTION TO DIGITAL PRESENTATION- IMPRESS 

5.1 Introduction to Digital Presentation 

5.2 Getting started with LibreOffice Impress 

5.3 Main Impress Window 

5.4 Close LibreOffice Impress 

5.5 Close a Presentation 

5.6 Creating Presentation 

5.7 Slide Layout 

5.8 Save a Presentation 

5.9 Contents in Slide 

5.10 Formatting Toolbar 

5.11 Adding Images in Slide 

5.12 Formatting images 

5.13 Slide Show 

 

5.1 INTRODUCTION TO DIGITAL PRESENTATION 

Gowri has prepared one of her favorite chapter of EVS named as “Foods we 

eat” in digital form. For this she used Writer options which she has learnt till 

now. She went to her teacher and requested to represent it to all her 

classmates.  

 

 

 

 

 

While all were appreciating her efforts, her classmate  

Aryan asked their teacher -Madam yesterday I saw my brother 

preparing his science project report on the system. That was very 

impressive. Each page of the report was moving itself and the text 

and images in the page were also moving in different ways.  

Madam, can we prepare Gowri’s document as my brother has prepared for 

himself?   
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“YES, Of course Aryan.” Teacher replied. Your brother was working on a 

presentation software in which we prepare contents as digital presentations.  

Oh, that seems very interesting mam, please talk more about digital 

presentation – Aryan asked. 

All students get excited to know more about this new way of representation. 

Many students start asking simultaneously.  

Ok, Ok. Just sit quietly and have patience students. Let us learn together the 

digital presentation software.  

 Teacher describe definition as: 

Digital Presentation is a way of presenting thoughts or messages (simple or 

difficult) using Digital Tools. Each page is known as slide. 

Teacher gave some widely used presentation software names 

 Microsoft Power Point Presentation

 Google Slides

 Libre Office Impress

Aryan curiously asks to teacher which one we are going to learn 

to make our topic presentable. 

Teacher replied - all can be used. Here we will continue with Libre 

Office Impress. 

 

 

5.2 GETTING STARTED WITH LIBRE OFFICE IMPRESS 

Gowri asked mam, “please tell how to open it? Is it same as we are doing with 

Writer?” 

Teacher starts demonstrating it step by step. 

Impress is one of the applications in Libre Office suite which is a digital 

presentation software to make impressive presentations.  

Try Now- Search for Presentation software other than given here with 

the help of your teacher and note them. 
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Fig 5.3 

6. Workspace: This is the area on presentation window where we actually make

slides and add contents. 

8. Status Bar: As name suggests it gives the information about current status

of presentation like slide number, language, zoom slider. 

First impression of Impress was good over the students as they were about to 

enter in presentation world. 

Try Now- Type word “Libre Office” in search box near to window button 

on desktop. Now noted down Liber office applications other than Writer 

and Impress. 
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5.4 CLOSE LIBREOFFICE IMPRESS  5.5 CLOSE A PRESENTATION 

 

 

        

   

 

  Fig 5.4    Fig 5.5 

Aryan tried to close the active file and wanted to take new so 

that he can try by herself. He tried this same way as he learnt 

in writer.  And he successfully did it. Class gave a round applause 

for him. Yes, closing is exactly same as in writer. 

File in Impress is saved with extension   .odp  

 

5.6 CREATING PRESENTATION 

Gowri is very excited after getting first success. She asked her teacher to 

allow her to explain how to take a new file. 

5.6.1 Using New option: Gowri opens new file in the same way as was in 

Writer using  

1. Select File -> New  2. Click on new icon  3. Press Ctrl + N  

5.6.2 Using Template:  

Teacher:-Well, done Gowri. 

Do you remember Template?  

Gowri:-Yes, we 

create documents 

in writer with the 

help of template. 

Can we use the same way here 

and create new file using 

template?  Fig 5.6 
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Fig 5.10 

 

5.8 SAVE A PRESENTATION 

 

 

Fig 5.11 

Try now- First take a new slide. Select title and 3 content layout. Now try 

to change this slide layout to blank slide. Could you? 

We have same options to 

save our file i.e. Save and 

Save As 

Yes Gowri and I have saved my file 

using save option. If I need to save 

my file under new name I will use 

Save As option, otherwise I can 

keep on saving it under current 

name using Save option. 
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5.8.1 Save: Ctrl+S (see fig 5.12, fig 5.13).  

5.8.2 Save as: Ctrl + Shift + S (see fig 5.12, fig 5.13).   

         

              Fig 5.12       Fig 5.13 

 

 

5.9 Contents in Slide 

I hope till this point you are ready with your two slides. Now let us take next 

step to add contents in the slide to convey your thoughts. – Teacher continues. 

5.9.1 Add Content: They used   

 Keyboard keypad 

 Copy Ctrl+C or by right click on selected 

content and choose copy. 

 Cut Ctrl+X or by right click on selected 

content and choose cut. 

 Paste Ctrl+V or by right click on selected 

content and choose paste. 

5.9.2 Delete Content: To 

delete the content they used  

  

 Right click by mouse 

and choose delete. 

 Press delete / 

backspace key from 

keyboard. 

Try now- Did you observe save as dialogue box opened only once when 

you save file with save option but opened every time when you use save 

as option?  

Let us take a 

new slide 

I will use copy and 

paste to add contents 

faster as I have also 

used same in writer. 

Aryan, see I have made 

slide for My Hobbies 

I will copy the content 

from my first slide to 

second and make some 

changes by deleting 

some lines using del key. 
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7. Font Colour Highlight Colour: 

  

5.10.2 Paragraph Formatting: 

 Bulleted List & Numbered List 

 Alignment     

 Vertical Alignment: These alignments are used to 

position the text vertically in a proper space. These are 

of three types. 

Align Top Centre Vertically   Align Bottom  
Text aligned at top side 

of the space Text aligned in the middle 

of the space. Text aligned at bottom 

side of the space 

 

 Set Line Spacing 

 Increase decrease line spacing 

 

 

Fig 5.15 

 

  

We are already 

familiar with list 

preparation and 

alignments in 

 

You remember how we 

give spacing between 

lines in writer. Just 

repeat that. So easy  

Check out, I have 

made 3 slides using 

different layouts. 
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5.11 ADDING IMAGES IN SLIDE 

Well done Aryan!! You did a good job. Let me allow to do some changes in your 

slide 3. See in fig 5.16 

 

 

                     

 

Fig 5.16 

You can make your slides more 

presentable with the help of Images 

and pictures as they are the best 

way to express thoughts and 

feelings in a simpler manner. It is 

always easy to understand and 

memorize things through visuals. Hence adding 

images to presentation makes it effective.  

 

5.11.1 From File: Click on insert->image orclick on insert image icon on 

standard toolbar   

   

    Fig 5.17     Fig 5.18 

5.11.2 From Gallery: Gallery contains images inbuilt in Impress just exactly 

the same way as in writer. Click on Insert -> Media -> Gallery or Click on 

Gallery icon on Task Pane  

Slide is looking more 

impressive now with 

images. Let us learn 

how to add images. 

Lets try to add image 

as we did in write.  

See we have both 

options 

Insert -> Media -> 

Gallery and Insert -> 

image option. 
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            Fig 5.19        Fig 5.20    Fig 5.21 

 

 

 

5.12 FORMATTING IMAGES 

 

Aryan is eager to try following image 

operations besides Cut, Copy, and Paste. 

√ Move    √   Resize   √ Rotate 

Let us discuss them briefly. Take the picture of a field. 

5.12.1 Move: To move the image from one position to other. 

Follow the following steps. 

 Select the image. Mouse cursor get 

changed to  . 

 Press left mouse button and drag the 

image to its desired position. (Fig 5.22)     Fig 5.22             Fig 5.23    

 Leave the mouse button. (see fig 5.23) 

5.12.2 Resize: Let us change the size. 

 Select the image by clicking on it. Selection handles appears on the 

boundary of image. 

Did you observe File helps you to insert your own image in presentation 

while from gallery you will get the pre-stored shapes of presentation? 

Can I move, 

resize and rotate 

image here. 
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Do you know this moving of slides is known as Slide 

Show? Slide show can be done from  

 First slide 

 Current slide 

5.13.1 From First Slide:  To start your slide show from 

beginning that is from first slide of your presentation  

 Click on Slide show -> Start from First Slide on Menu 

bar. 

Or press F5. 

5.13.2 From Current Slide:  To start your slide show from the 

current slide on which you are working presently of your 

presentation  

 Click on Slide show -> Start from 

Current Slide on Menu bar. 

Or press Shift+F5. 

 

 

 

Following points should be considered to make a good quality presentation: 

 Try to include 6 to 8 lines in a page 

 Font size must be in such a way that audience can easily read. 

 Combination of colours should suit the surroundings. 

 Always make presentation according to the audience. 

  Use correct grammar and spelling in contents writing. 

Let us revise we have learnt: 

 Libre Office Impress is used to make presentations. 

 Impress files have extension .odp 

 Contents written over slides. 

 Templates can be used to create new file. 

 Slide Layout is used to select the required format of slide according to 

contents. 

Fig 5.27 

Try now- Take a pic of yours and insert in slide. Now take one more 

pic of yours but with different pose and insert in next slide to 

previous one. Now start slide show from first slide and observe. 

See my slide show. It is 

so beautiful. Just press 

Shift +F5. 
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 Formatting toolbar contains all options as of writer.  

 Images can be inserted in to a slide from a file or from a gallery. 

 An image can be resized, moved, Rotated. 

 Slide show presents each slide one after another. 

 Slide show can be from Current slide or from the first slide.  

Exercise 

Something To Know 
A. Answer the following questions. 

1. What is the difference between Align Centre and Centre Vertically 

Alignment?  

2. Mahima was assigned to make a slide. She was asked to write 3-4 lines 

about herself. She wants to write her name, her address, her hobbies 

and school name in a slide. Help her to choose the best suitable option to 

write content. 

3. Write the purpose of the   option. 

4. Ajay took a picture of his house and saved it in his system. He wants to 

use this house picture in his presentation. Suggest him the steps to use 

this picture in his presentation. 

5. Name any three options available in Task Pane. 

B. Fill in the Blanks. 

i. Rotate icon is present on the _______________ toolbar. 

ii. Shift + F5 key combination is used to see slideshow from 

___________ slide. 

iii. Bulleted list is used to prepare _________ kind of list. (Ordered / 

Unordered) 

iv. Presentation are always prepared according to __________ . 

(audience / presenter) 

v. New slide can be taken from the ______ option. 
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6. LIBREOFFICE CALC 
6.1. What is Calc  

6.2. How to start LibreOffice Calc  

6.3. Parts of Calc Window  

6.4. Title Bar  

6.5. Menu Bar  

6.6. Toolbars  

6.7. Status Bar  

6.8. File Menu  

6.8.1. Creating a new spreadsheet  

6.8.2. Opening an existing spreadsheet  

6.8.3. Saving a spreadsheet  

6.8.4. Closing a spreadsheet  

6.8.5. Print Previewing a spreadsheet  

6.8.6. Printing a spreadsheet  

6.9. Edit menu  

6.9.1. Undo  

6.9.2. Redo  

6.9.3. Cut & Paste  

6.9.4. Copy and Paste  

6.9.5. Find  

6.9.6. Find and Replace 

6.1 What is Calc 
Gowri went with her elder brother to a fruit shop to purchase oranges and 

apples as her mother told that they are good for health. She 

went to the shop and found that apples were Rs 80 per kg and 

oranges were Rs 50 per kg. Her brother purchased 2 kg apples 

and 3 kg oranges. She saw that the shopkeeper did the 

calculation on computer and told Gowri’s Brother to pay Rs 310 giving him 

computer printed bill. Gowri was very surprised to see it. She even asked her 
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brother about it. Her brother told that there are many soft wares which are 

used for doing calculations and making bills. 

Next day, Gowri asked her teacher about such type of software. Her teacher 

told that there are spreadsheet soft wares, which can be used for performing 

calculations. Few spreadsheet soft wares are: 

 MS Excel 

 OpenOffice Calc 

 LibreOffice Calc 

 LibreOffice Calc is spreadsheet software of LibreOffice Suit. Data is entered 

in a spreadsheet and then data is manipulated and calculated in a spreadsheet. 

LibreOffice Calc is similar to MS Excel. In Calc, there are various functions 

which can be used to create formulas which perform various calculations. A 

spreadsheet is a grid of rows and columns which interactively manages and 

organizes data in rows and columns. It is also known as Electronic Spreadsheet.  

6.2 How to start LibreOffice Calc 
The teacher started explaining to the students the method to open 

LibreOffice Calc. The students were excited to know about it. 

Extension of Calc is .ods.  

In Windows, double click on the shortcut of LibreOffice Calc on Start Menu 

or on desktop to start LibreOffice Calc. Here you can create a new 

spreadsheet by the following command as shown in Fig Create -> Calc 

Spreadsheet

 Fig 6.1 

6.3 Parts of Calc Window 

The students were curious to know about various parts of Calc window. The 

teacher explained about various parts of Calc window.  
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6.4 Title Bar 
 The Title bar is located at the top of the spreadsheet as shown in Fig 6.2. It 

is topmost bar of spreadsheet. When a new spreadsheet is created, it takes 

name as Untitled 1 and so on.  

Gowri :- Mam it is same as in writer and impress. 

Aryan: - Yes, we had title bar in Impress and Writer too. 

Teacher: - Yes, find out the default names of the file in them. 

Help Gowri and Aryan to find out default names of files in writer and 

Impress. 

 

 

 

 

 

 

 

 

 

 

6.5 Menu Bar 

The Menu bar is located just below Title bar as shown in Fig 6.2. It has 

various menus which perform different tasks. Each menu item has a submenu 

located with it, also known as pull-down menu.  

Aryan: - I can see menus like File, Edit, View, Insert, Format, 

Styles, Sheet, Data, Tools, Window and Help on the screen. Some 

similar menu options were there in Writer and Impress too. 

Fig 6.3 

   

 

 

 

 

Fig 6.2 
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Gowri: - Yes, but there is some difference as each application 

is meant for different work so menu and options are different. 

Only common options are those which are used in all 

applications.  

6.6 Toolbars 

By default, the Standard and Formatting toolbar are displayed under Menu 

Bar. You can view various toolbars.  

 

Standard Toolbar    Fig 6.4 

 

Formatting Toolbar           Fig 6.5 

6.7 Status Bar 
 

The status bar is situated at the bottom of the window. 

 

Status Bar     Fig 6.6 

6.8 File Menu 

6.8.1 Creating a new spreadsheet 
In File menu, the teacher showed the students the option to create new 

spreadsheet. Aryan asked Gowri to help him create a new spreadsheet.  

Gowri: - When we open any application, there is always a new file 

which opens by default with the default file name. Let me show you 

the steps to create a new spreadsheet are as follows: 
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1. Go to File Menu 

2. Select the Submenu Open 

3. File-> Open 

4. The shortcut to open an existing spreadsheet 

is Ctrl+O. 

5. It can also be done by clicking button on the 

Standard Toolbar. 

6.8.3 Saving a spreadsheet 

Aryan wanted to save the spreadsheet created by him. He 

asked the teacher about how to save the spreadsheet. The 

teacher then told the steps to save a spreadsheet. They 

are as follows: 

1.  Go to File Menu 

2. Select the Submenu Save 

3. File-> Save 

4. The shortcut to save a spreadsheet is       Ctrl+S 

5.  It can also be done by clicking button on the Standard Toolbar. 

 

Fig 6.10 

6.8.4 Closing a spreadsheet 

After the work was over, Aryan asked the teacher the way to close the 

spreadsheet. The teacher told the steps to close a spreadsheet. They are as 

follows: 

Fig 6.9 
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1. Go to File Menu 

2. Select the Submenu Close 

3. File-> Close. 

4. The shortcut to close a 

spreadsheet is Alt-F+C                                                    
                                                 Fig 6.11 

6.8.5 Print previewing a spreadsheet 

Aryan asked the teacher 

how it looked on paper? The 

teacher showed her the 

print preview of the 

spreadsheet prepared by her. The print 

preview shows what a spreadsheet will look 

like if printed. All the students of the 

class were excited to see print preview. 

The steps are as follows: 

1. Go to File Menu 

2. Select the Submenu Print Preview 

3. File-> Print Preview 

4. The shortcut to print preview a spreadsheet is Ctrl+Shift+O. 

5. It can also be done by clicking the button on the Standard Toolbar. 

6.8.6 Printing a spreadsheet 

The teacher took the print out of the 

spreadsheet and showed to students. 

The students were really excited to 

see it. Some of them wanted to show 

it to their parents. The print out is 

hard copy of the document. The steps 

to take print are as follows: 

1. Go to File Menu 

2. Select the Submenu Print 

3. File-> Print 
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4. The shortcut to print a spreadsheet is Ctrl+P. 

5. It can also be done by clicking the button on the Standard Toolbar. 

6.9 Edit menu 

6.9.1 Undo 

Gowri started crying as she deleted her work by mistake. The teacher told her 

to stop crying as she told the command to undo the changes. Gowri was happy, 

as all of her work was retrieved back. The steps to undo are as follows: 

1. Go to Edit Menu 

2. Select the Submenu Undo:  

3. Edit-> Undo:  

4. The shortcut to undo the changes in 

a spreadsheet is Ctrl+Z. 

5. It can also be done by clicking the 

button on the Standard Toolbar. 

6.9.2 Redo 

Gowri has also undo some formatting done by her on text, but she realized the 

text with formatting was better. Now she again wanted to make those changes. 

She asked the teacher about it. The teacher told her Redo the changes. After 

following the instructions given by her teacher, she was able to again format 

the text. The steps she followed are given below  

1. Go to Edit Menu 

2. Select the Submenu Redo 

3. Edit-> Redo 

4. The shortcut to redo the 

changes in a spreadsheet is 

Ctrl+Y. 

5. It can also be done by clicking the button on the Standard Toolbar.  

6.9.3 Cut & Paste 

Aryan had made a list in LibreOffice Calc. Now he wants to remove the list 

from one cell in the sheet to another cell in the same sheet. So he asked the 

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 76                                                  KVS DELHI REGION 2021 
 

teacher whether he has to retype it or do we have similar option of cut and 

paste as in Writer and Impress. The teacher explained that we have similar 

option here and there is no need to retype it. The steps are as follows:  

1. Go to Edit Menu 

2. Select the Submenu Cut 

3. Edit-> Cut 

4. The shortcut to cut in a 

spreadsheet is Ctrl+X. 

5. After cutting, the data is 

to be pasted.  

6. Edit-> Paste 

7. The shortcut to Paste in a 

spreadsheet is Ctrl+V. 

8. It can also be done by 

clicking the button on the Standard Toolbar. 

6.9.4 Copy and Paste 

Gowri had made a list in LibreOffice Calc. She tried to copy and paste the list 

from her experience in writer and Impress. The steps she followed are: 

1. Go to Edit Menu 

2. Select the Submenu Copy 

3. Edit-> Copy 

4. The shortcut to cut in a spreadsheet 

is Ctrl+C. 

5. After copying, the data is to be 

pasted. 

6. Edit-> Paste 

7. The shortcut to Paste in a 

spreadsheet is Ctrl+V. 

8. It can also be done by clicking the 

button on the Standard Toolbar. 
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Exercise 

Something To Know 

Q I.  State True or false:- 

1. The Cut option is in the File menu. 

2. The Print option is in the View menu. 

3. The shortcut for open is Ctrl+P. 

4. The Undo option is in the Edit Menu. 

5. The print preview shows what a spreadsheet will look like if printed. 

Q II. Match the following:- 

Column A    Column B 

1. Cut     Ctrl+V 

2. Print     Ctrl+Z 

3. Undo     Ctrl+Y 

4. Redo     Ctrl+X 

5. Paste     Ctrl+P 

      

Q III. Fill in the blanks:- 

1. The shortcut for creating new spreadsheet is _______________. 

2. The _____________feature is used to search a specific word. 

3. The shortcut to print preview a spreadsheet is 

_______________________. 

4. The shortcut for ___________ is Ctrl+C. 

5. The __________________ is the topmost bar of LibreOffice Calc. 

QIV. Answer the questions based on CCT: - 

1. Shivani wants to move the data from one cell of spreadsheet to another 

cell in the spreadsheet. Which feature of LibreOffice Calc is required 

to do this task? 

2. Vaibhav  wants to search a word ‘male’ in a spreadsheet and then change 

it to a word ‘boy’. Which feature of LibreOffice Calc will be used by 

him? 
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3. Geetika wants to remove all the changes made by her. Which feature of 

LibreOffice Calc will be used by her to remove all the changes? 

4. Vihaan wants to open an existing spreadsheet. Write the shortcut to 

open it? 

5. Name the bar which has different menus present on it. 
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7.EXPLORING WINDOWS 10 

 
 7.1 WHAT IS WINDOWS 10 

 7.2 FILE EXPLORER 

 7.3 DIFFERENT WAYS TO OPEN FILE 

       EXPLORER 

 7.4 COMPONENTS OF FILE EXPLORER 

 7.5 PANES OF FILE EXPLORER 

 7.6 MANAGING FILES AND FOLDERS 

 
7.1 WHAT IS WINDOWS 10? 

Aryan: - I was wondering, that whenever I switch on the 

computer, it shows windows 10 then comes to the desktop. Can 

you please tell me about Windows? 

Gowri:  Yes, why not. Windows is the operating system designed 

by The Microsoft and Operating system is what allows you to use 

the computer. There are different versions of windows like 

Windows NT, Windows95, Windows7, Windows10 and others also. 

We are going to learn about Windows 10. 

 

 
 

Fig. 7.1 windows 10 
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7.4 Components of File Explorer 
Aryan : Now please explain the components of file explorer. 

Gowri:  Please see the picture carefully, I have marked the points  

 

 
Fig 7.5 

 

1) Left pane – It is used to get to all kinds of locations and drives.  

2) Back, forward and up buttons – These are used to navigate through 

locations or files.  

3) Ribbon – The Ribbon can be used for copying, moving, creating new 

 folders, e-mailings, zipping items, changing views etc.  

4) Address bar – It is used for entering or selecting a location.  

5) File list – This is where the contents of the current folders are 

displayed.  

6) Search Box – It is used to enter a word or a phrase to look for an item 

in  the current folder.  

7) Status Bar – It can be used to view the total number of items in a 

location, or the number of selected items and their total size.  
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7.5 PANES OF FILE EXPLORER 

Aryan:  When I opened the File Explorer, I saw names of different panes. 

What are these panes? 

Gowri: On clicking the View menu you can see the various panes available as 

shown below these panes are:  

i) Preview Pane: provides a preview of the selected item, such as a 

picture. 

ii) Details Pane: It displays information about the selected item, such 

as the file name, type, date modified, dimensions, size, and date 

created. 

iii) Navigation Pane: The Navigation pane provides a tree structure to 

navigate folders and drives on your computer 
 

See the difference between three views by analyzing the following 

pictures: 

 

 
Fig 7.6 Detail Pane 

 
Fig 7.7 Preview Pane 
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Fig. 7.8 Navigation pane 

 

Aryan:  How can I see subfolders of any folder?  

Gowri:  Left Pane contains list of drives, folders in the computer. 

 Then on clicking a window/folder like Desktop, 

Downloads, Recent Places etc. you can get the content of the 

window/folder on the Right Pane of the Windows Explorer.  

 And on selecting and clicking a disk drive, you can get the 

files and folders of that particular drive on the Right Pane of 

the windows explorer and all the folders of that drive on Left 

Pane of the windows explorer.  

 

 

7.6 MANAGING FILES AND FOLDERS 

Aryan: Ok, now please tell me how can I manage files and folders in File 

Explorer? 

Gowri: There are different ways to manage Files and folders:  

 

 As I told you the Left Pane contains a list of drives and folders and when 

you select a folder from the left pane, its subfolders will be displayed in 

the right pane. 

 You can even directly drag and drop file(s) or folder(s) from one location 

to another location same as copy and paste. 
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Exercise 

Something to Know 
 

A. Answer the following questions. 

 What is Windows? 

 What do you mean by file explorer? 

 Write the names of different panes in file explorer? 

 Is the window explorer same as the file explorer? 

 Write any two basis on which you can sort the files and folders? 

Fill in the Blanks 

1. Sort by button is available under ________tab.  

2. _____________ Pane contains list of drives, folders in the computer 

3. _____________ is used for entering or selecting a location. 

4. The pane that shows the size and author of file or folder 

is______________. 

5. ______________ is the operating system designed by Microsoft  

 

B. Match the Following. 

1. Copy &paste a) used for copying, moving, 

creating new folders 

2. Operating system b) View tab 

3. Preview pane c) Window NT 

4. Ribbon . d) Content of file or folder 

5. Group by e) Drag & Drop 

 

C. Answer in one word. 

1.  Window explorer in windows 10 is known as__________________ 

2.  Pane which displays the subfolders of the folder selected in left pane 

_________________ 

3. It can be used to view the total number of items in a location, or the 

number of selected items and their total size. ________________ 
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4. It provides a graphical interface for the user to navigate and access 

the files stored in the computer _____________ 

5. Which menu contains Design, Navigation and Detail panes 

____________ 

 

Something to Do 
 

1. Find out the different versions of Windows and write in your notebook 
2. Open file explorer and see the drives and folders on your system 
3. Note down the size of any file created by you. 
4. Try to view the files by selecting all the three panes. 
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8. CLASSIFICATION OF COMPUTERS 
 

 

8.1. CLASSIFICATION OF COMPUTERS 

8.2. ANALOG 

8.3. DIGITAL 

8.3.1. SIZE AND PERFORMANCE 

8.3.2. SUPER COMPUTER 

8.3.3. MAIN FRAME 

8.3.4. MINI COMPUTER 

8.3.5. MICRO COMPUTER 

8.3.6. EMBEDDED  

8.3.7. PURPOSE WISE 

8.4. GENERAL PURPOSE 

8.5. SPECIAL PURPOSE 

8.6. HYBRID 

  

 

8.1 The Classification of Computers 
Aryan:   Hey, yesterday I have seen in T.V that the computers we are using is 

one kind of computer. There are different types of computer. Can you 

please explain?  

Gowri:   Yes, why not. Today I will tell you about “The 

Classification of Computers”. And you will 

be surprised to know that there are 

different categories on the basis of which 

computers are classified. 

 

Aryan: Really, please tell me in detail. 
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Types of Digital computers according to the purpose they are used 

for 

1. Special purpose computers: They are designed to do 

single specific task.  

For Example – computer for military application or 

purpose, computers at billing counters in malls etc.  

 

                                                           Fig. 8.5 

 

2. General purpose computers: They are designed to solve wide variety of 

problems having different sets of inputs. For Example – computers for 

banking, sales analysis etc. 

 

Types of Digital computers according to size and performance 

 

1. Super computers : These computers are designed to be used for doing 

extremely complicated computations , that also in minimum possible time. 

They are best used in Weather 

forecasting, Nuclear Science, 

Aerodynamic modeling etc. 

These are of very big size. 

                                                Fig 8.6 

 

2. Mainframe computers: are 

designed to handle large volumes of data 

and size is smaller than super computer. 

 

 

 

            Fig 8.8 

  

3. Mini computers: Minicomputers are used for 

scientific and engineering computations, business-

transaction processing etc. 

   

                                                     Fig 8.8 
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4. Microcomputers: These are designed to be used by single users for 

performing basic operations like educational activities, playing games. 

These are mainly used in homes, offices, shops, school etc. 

 

5. Embedded computers: These computers 

are designed to be used within the circuit 

of other appliances such as television, 

washing machine, smart watches, car etc.  

 

 

                                               Fig 8.9 

Aryan:   Thank you so much, you have explained everything in detail 

Gowri:  Welcome, but I want to tell you one more thing about Super 

computers. The super computers produced by India. 

 

Aryan:  Wow, tell me. 

Gowri: PARAM series  

  

 

 

 

 

  

 

 

 

 

 

EXERCISE 

SOMETHING TO KNOW 

 

A. Answer the following questions. 

 What are the types of computer on the basis of data they can handle? 

 Name the type of computer used in smartwatches? 

 Give one example of Special purpose computer? 

 Name two supercomputers made by INDIA? 

PARAM series by CDAC (Centre for Development of Advanced 

Computing) and PACE(Processor for Aerodynamic Computation and 

Evaluation) by ANURAG (Hyderabad based Advanced Numerical 

Research and Analysis Group) are supercomputers produced by 

India 

 

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 92                                                  KVS DELHI REGION 2021 
 

 Write basic difference between Analog and Digital computers? 

 

B. Fill in the Blanks 

1. Full form of CDAC_______________________________________ 

2. _____________ are used for scientific and engineering computations 

3. _____________ are analog computers controlled by digital computers 

instead of human beings. 

4. Micro computers are bigger in size than______________computers. 

5. The category of computers we use at home____________ 

 

D. True/False 

1. General Purpose computers are designed to do single specific task. 

2. Digital computers work on discrete data. 

3. Super computers are used in weather forecasting. 

4. In hospitals hybrid computers are used. 

5. PARAM is first minicomputer. 
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9.WINDOWS ACCESSORIES 

 

9.1 MODES OF VIEW 

9.2 FILE NAMING CONVENTION 

9.3 SEARCHING FILES 

9.4 CREATING SHORTCUTS 

9.5 CALCULATOR 

9.6 ONSCREEN KEYBOARD 

9.7 MAGNIFIER 

9.8 TASK VIEW 

 

9.1 MODES OF VIEW 

Aryan:    Hello, I tried the different options learnt in previous 

chapter. I saw some options like large icons, small icons. What are 

these options?  

Gowri:    OK, let us start learning these options’ these are known 

as MODES OF VIEW. 

 

Aryan:  MODES OF VIEW? Please explain. 

Gowri:  Yes, why not. You can change how your 

folder and file icons look, as well as display 

different information about them.  

Note:  Changes you make will apply to the contents of the 

current folder only. 

 
Fig. 9.1 
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Different options available are: 

 Extra Large Icons 

 Large Icons 

 Medium Icons  

 Small Icons 

 List 

 Details 

 Tiles 

 Contents. 

9.2 FILE NAMING CONVENTION 
Aryan: Ok, But when I was working with different modes on files, 

I saw names of different files. Is there some convention to be 

followed while naming the files?  

Gowri: All the file systems follow the same general naming 

conventions for an individual file: “a base file name and an optional extension, 

separated by a period”.  

Aryan: Extension is what defines which application the file belongs too. For 

example we had done calc and extension for cal file was .odt.  

Gowri: - Some of the basic rules followed while naming files in Windows are 

listed below:  

 Use a period to separate the base file name from the 

extension in  

    The name of a directory or file.  

 Use a backslash (\) to separate the components of a path.   

 Use a backslash as required as part of volume names, for 

example, the     "C:\" in "C:\path\file". 

Do not assume case sensitivity. For example, WINDOWS 

and windows should be treated equal. 

 Use any character in the current code page for a name, 

including Unicode characters and characters in the extended character 

set (128–255) except for the following reserved characters: 

 > (greater than)  

 : (colon)  

 " (double quote)  

 / (forward slash)  

 \ (backslash)  
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9.8 TASK VIEW 
Aryan: OK, What is the use of Task View? 

Gowri: Actually Task View is a task switcher and virtual desktop system. Task 

View allows a user to quickly locate an open window, quickly hide 

all windows and show the desktop, and to manage windows across 

multiple monitors or virtual desktops. 

It is among the first features new to Windows 10. 

You will get the following screen when you click this option in taskbar. 

 

Fig. 9.9 

 

EXERCISE 

SOMETHING TO KNOW 

 

C. Answer the following questions. 

1. Write any four options in which we can view our folders? 

2. What is the use of Magnifier? 

3. Write the steps to open calculator? 

4. What is the use of creating shortcuts? 

5. How shortcuts can be distinguished from Original file? 

 

E. Fill in the Blanks 

1. When you type inside search box, Windows displays 

a  __________ ribbon which provides numerous options you can select 

for your search. 

2. _____________ is a task switcher. 
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3. Use a ____________to separate the base file name from the 

extension in the name of a directory or file.  

4. ______________ is a keyboard that can be used to move around 

the screen. 

5. Way to quickly turn on Magnifier is: _______________________ 

 

F. Match the Following. 

1. New feature in windows 10 f) calculator 

2. start button g) Tiles 

3. < (less than)  

 

h) Task View 

 

4. Modes of view 

i) Reserved character 

 

  

True/ False. 

1.  Task view is available in start menu._____________ 

2. Save search is used to save the search criteria for a future 

search_____ 

3. Colon( : ) is used  to separate the components of a path____________ 

4. Large icons, Tiles can change how your folder and file icons 

look.________ 

5. On screen keyboard is available from start menu.___________ 

SOMETHING TO DO 

1. Open the file explorer and change the view to extra-large, medium, tiles 

to see the effects. 

2. Find the shortcut to open Onscreen keyboard and Task view and write in 

your notebook 

3. Open on Screen keyboard and type the name of your friends. 
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Appendix I  
ANSWERS 

Chapter 1 

A:1. Ans. Stamps tool is used to insert various inbuilt picture in your drawing.  

Two name of stamp:  frog, Santa, flower etc.  

2. Ans.  We use shortcut keys for doing fast work on computer. 

 

3. Ans. Magic tool is used to draw and give amazing effects to a pictures  

e.g. Bricks , Foam, Emboss etc.  

 

4. We can delete a drawing by following steps : 

Step 1: Select on the open Tool   you will see all the saved drawing 

thumbnails on the screen 

 Step 2: Select the drawing which you want to delete 

Step 3: Click on the Erase button present at the right bottom of the 

screen. 

Step 4: Then click on Yes, Erase it! 

5.  

   Step 1: Select on the open   you will see all the saved drawing thumbnails 

on the screen. 

Step 2: Click on the Slides  options  

Step 3: Select the drawing which you want to display in your slide show 

Step 4: Each picture get a number which you select, you can reorder the 

pictures 

Step 5: Adjust the speed of the slides by selecting the sliding scale. 

Step 6: Click on the play  button to begin the slide show 

 

B. Fill in the Blanks 

1. Text or Label 

2. Play  

3. Kaleidoscope effect 

4. Ctrl + N 

5. Rail  

 

C. Match the Following. 
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1 ---- b 

2 ---- c 

3 ---- e 

4 ---- d 

5 ---- a 

D. Select the correct answer for each question. 

1. C 

2. B 

3. C 

4. B 

5. A 

E. State True  or  False  

1. False 

2. True 

3. True 

4. False 

5. FalseANSWERS 

Chapter 2- Scratch (Revision) 

A. Answer the questions given below: 

Q: -1 You have seen so many blocks in the scratch now. Write their names 

to do following tasks. 

Name of Block  

a. “glide… secs to random position”. 

b. “say…. for… Secs”  

c. “Turn 50 degrees”  

d. “move -5 steps”  

e. next costume”  

f. “change size by…” (+ve value) 

Q: -2 Ans: - “Looks” block 

Q: -3 Ans: - This block is used to fly the sprite to a particular position 

which is also known as (x, y) position or to a random position or to a mouse 

pointer location.  

Q: -4 Ans: - This block is a top block in every script, as it can join more 

blocks in downward side only and also it has “hat” shape from top side and is 

the start of the script. 
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Q: -5 Ans: - This block is used to move the sprite 20 steps in a backward 

direction. 

Q: -6 Ans: - This block is a “hat” block and used to do specific tasks, when 

particular background changes. This block has a drop-down list, from there 

you can choose a particular background from the given list of backgrounds 

chosen by us. 

 

B. Fill in the blanks given below: - 

1. “Turn 50 degrees” block, is used to turn the sprite left side. 

2. “turn” block is under “Motion” block. 

3. “Paint” icon is used to draw the sprite, when it is required. 

4. Code, Costumes and Sounds are the tabs available in scratch. 

5. All the selected sprites will appear in the Sprite list. 

6. “Costumes” tab is replaced with “Backdrops” tab when we will choose, 

stage option in scratch. 

C. Write the name of “type of block” for the following blocks. Also 

write the name of block under which this block exists: - 

Name of the block   Type of Block  Name of Block 

1. “switch costume to…”   Stack block  “Looks” block 

2. “wait … seconds”    Stack block  “Control” block 

3. “say… wait for … seconds”  Stack block  “Looks” block 

4. “when backdrop switches to” Hat block   “Looks” block 

5. “when flag clicked”   Hat block   “Events” block 

 

ANSWERS 

Chapter 3 - Scratch 

Q: -1 You have seen so many sound effects in scratch now. Write their 

names to do the following tasks. 

 Name of Block  

a. “Change…. effect by…”  

b. “Change volume by…” (+ve value) 

c. “Change pitch effect by…” (-ve value) 

d. “Clear sound effects” 

e. “set pitch effect to 100”  
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f. “stop all sounds” 

Q: -2 Ans: - “Sounds” block.  

Q: -3 Ans: - This block is used to set the pitch effects of sounds to a 

particular value. 

Q: -4 Ans: - This block is used to play the sound in earphones. It will 

change the ear from where sound is played. If value is +ve, it means sound will 

play more from Right ear. If value is -ve, it means sound will play more from 

Left ear. If the value is 0, means sound will play normal. which we will give. 

So, -100 means sound plays completely in left ear and -100 means sound plays 

completely in right ear in headphones.  

Q: -5 Ans: -This block is used to increase or decrease the volume of sound 

by a particular value. If value is a +ve number then sound will increase and 

when the value is a -ve number then sound will decrease.   

A. Answer the questions given below: - 

1. Ans: - This block is known as c-block, which is used to repeat the 

blocks of instructions till some condition is false. If the condition 

becomes true, then it stops the blocks written inside this block rather 

runs the next instructions written after the repeat block.  

2. Ans: - “Control” block 

3. Ans: - “repeat” block will run the blocks of instructions written under 

it until the condition becomes false, while “forever” block will run the 

blocks of instructions written under it infinite times. 

4. Ans: - “if...then… else” block is also known as “c-block”, which is used 

for asking the questions and returning the answer in True or false. If 

condition is true, then the blocks written inside this c-block will be 

executed once, otherwise the blocks written inside the “else” block will 

be executed once.  

5. Ans: - “stop all” block is a “cap” block, it will stop all the scripts 

running in scratch project, either on this sprite or any other sprite. 

6. Ans: - “play sound until done” block is a stack block and this block 

chooses the sound and play it and finishes it before moving to the next 

script means pause the script till it ends. 

7. Ans: - “cap” block is the block which ends the script here, means no 

more block can be added after that block. We can also say it as the 

reverse of “hat” block. “Hat” block is the start of the script and while 

“cap” block is the end of the script.  

8. Ans: - 3 blocks are available under extension “Text to Speech”. 
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B. Fill in the blanks given below: - 

1. “cap” block, ends the script. 

2. “touching mouse-pointer” block is under the “Sensing” block. 

3. “stop this script” block is used to stop all the codes of only the sprite 

where it is written. 

4. “touching sprite2?” block is used for checking whether the sprite2 is 

touching the sprite under which code is written. 

5. “repeat until” block is a “C-block” block. 

6. “Text to Speech” Extension has blocks which helps the sprites to 

speak. 

 

 

ANSWERS 

Chapter 4 – LibreOffice Writer 

A. Answer the following questions  

1. Pattern option gives background to page whereas bitmap used to give image 

in background to page. 

2. Using Insert->image 

3. The area between the actual page content and the edges is said to be the 

Margin. 

4. 8.27, 11.69 

5. insert->page break or press Ctr+Enter 

B. Fill in the Blanks 

1. Page tab, 2. increase or decrease, 3. page, 4. indent, 5. page size  

C. Match the following 

a) page break   q) to move to a new page  

b) flowcharts are part of  s) shapes  

c) page style in t) format menu 

d) line spacing p) single, double, 1.5, proportional 

e) spacing before lines r) indentation  
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D. Select the right option 

i. a   ii. c   iii.  b   iv.  d   v. b 

E. True/False 

a) False, b) True, c)  False, d) True, e) True 

 

 

ANSWERS 

Chapter 5 – Impress 

A. Answer the following questions  

1. Centre align move the text at center of space horizontally but Vertical 

Centre place the text exactly at Centre vertically 

2. Bulleted list in Title and content slide 

3. To rotate an image 

4. Insert->File-> choose picture 

5. Properties, Gallery, Styles, or any three 

B. Fill in the Blanks 

i. Line and filling toolbar, ii. Current, iii. Unordered, iv. Audience, v. Slide 

C. Match the following 

a) Impress File s) Saves as file.odp 

b) Slides comes one after 

another in 

t) Slide Show 

c) Resize can be applied over p) a picture, image 

d) Insert - > Media ->  q) Gallery 

e) to clear Direct formatting r) Ctrl + Shift + M 

D. Select the right option 

i. d   ii. a   iii.  d   iv.  a   v. c 

E. True/False 

a) False, b) False, c) True, d) False, e) True 

 

Answers 

Chapter :- 6 

I 1. False  

2.  False  

3. False 

 4. True 
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 5. True 

II. Cut - Ctrl+X 

     Print- Ctrl+P 

     Undo - Ctrl+Z 

     Redo - Ctrl+Y 

     Paste - Ctrl+V 

III 1. Ctrl+N 

    2. Find 

    3.  Ctrl+Shift+O 

     4. Copy 

     5. Title bar 

IV 1. Cut & Paste 

     2. Find & Replace 

     3. Undo 

     4. Ctrl+O 

      5. Menu bar 

 

ANSWERS: 

Chapter 7 

A. Answer the following questions. 

1. Windows is the operating system designed by  Microsoft. 

2. It is the file management application used to browse folders and files. It 

provides a graphical interface for the user to navigate and access the files 

stored in the computer. 

3. The panes in file explorer are:  

i) Preview Pane  

ii) Details Pane  

iii) Navigation Pane 

4. Yes, from windows 7 window explorer is known as file explorer. 

5. Date modified, name (any other you can write of your choice) 

 

B. Fill in the Blanks 

1. View 

2. Left Pane 

3. Address Bar 

4. Design Pane 

    5. Windows 
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C. Match the Following. 

 1-e, 2-c, 3-d, 4-a, 5-b 

D.  

E. Answer in one word. 

1. File explorer 

2. Right pane 

3. Status bar 

4. File explorer 

5. View menu  
 
 

ANSWERS 

Chapter 8 

 

A.Answer the following questions. 

1. There are three types of computers on the basis of Data they can handle 

a.Analog 

b.Digital 

c. Hybrid 

2. Embedded computers 

3. Banking, ATM (any other you know)  

4. PARAM, PACE 

5. Analog computers are those computers in which data is represented in the 

form of continuously varying physical quantities 

 

Digital computers works on discrete data. 

 

D. Fill in the Blanks 

1. Centre for Development of Advanced Computing 

2. Mini computers 

3. Hybrid Computers 

4. Embedded 

5. Micro computers 

 

C.  True/False 

False, true ,true,true,false 
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ANSWERS: 

Chapter 9 

A.Answer the following questions. 

1. Extra Large Icons, Large Icons, Medium Icons, Small Icons, List, Details, 

Tiles, Contents.(WRITE ANY FOUR) 

2. Magnifier is a screen magnifier app intended to magnify the content of the 

screen 

3.   Click Start Menu.  

Tap the lower-left Start button to show the Start Menu 

Select all apps and click Calculator. 

4.  Shortcuts are created to access the files from the convenient location of 

our use. 

5.  Shortcuts can be distinguished from the original file by the arrow that 

appears on the icon. 

E. Fill in the Blanks 

1. Search tools 

2. Task View  

3. Period 

4. Onscreen keyboard 

5. Windows logo key + Plus sign (+) 

F. Match the Following. 

1-c, 2-a, 3-d, 4-b 

G. True/ False. 

False, true, false, true, true 
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How to Install Libreoffice in your computer System? 

 
 

Four major components of software libreoffice are 

1. Writer Document   - A word processing component used to create 
letters, brochures, books, newsletters, biodata, project reports, 
documents to store quick references to useful information. 

2. Calc Spreadsheet - A tool for analysing data, creating charts and used 
for decision making. 

3. Impress Presentation - A tool which provides multiple features to 
create effective multimedia presentations quickly. 

4. Draw Drawing -  Software enjoyed by kids to show their creativity and 
draw beautiful paintings. 

 

INSTALLING LIBREOFFICE 

 

Step1- open the website using this link 
https://www.libreoffice.org/download/download/   
 

Copyright Number:- L-100560/2021 Registered With:- KVS Delhi Region



P a g e  | 114                                                  KVS DELHI REGION 2021 
 

 
 

Step2 - You can see the latest version of the libreoffice suite. From this 
page we can select our operating system from the drop down menu and 
press the yellow  DOWNLOAD button. Software starts downloading to 
our computer/laptop. 

 
 

Step3 - Click on file downloaded or open the file LibreOffice_7.0.3...msi 
from downloads 
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Step 4- Libreoffice installation begins. Keep pressing the next button and 
follow instructions to install the software 
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